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Abstract:  
 

The Student Records Management System (SRMS) is a modern digital platform based 

on IoT (Internet of Things), designed to streamline the process of managing student 

attendance during lectures and practical sessions at Kadri Zeka Public University in the 

Republic of Kosovo. This digital system enables professors to generate and store real-

time attendance records for students participating in lectures and exercises. The RFID 

(Radio-Frequency Identification)-based Student Records Management System is 

developed using PHP (Hypertext Preprocessor), HTML (Hypertext Markup Language), 

CSS (Cascading Style Sheets), MySQL (My Structured Query Language), and 

JavaScript. When a student scans their personal RFID card, the system logs their arrival 

time along with personal details. Additionally, when the same student scans their card 

again before leaving, the system records their departure time. This approach aligns with 

the Bologna System criteria, ensuring a fair and accurate assessment of student 

participation throughout the semester. This will also increase the transparency for 

students and professors in keeping all the records for each student and let to generate 

different reports by the end of semester. Beyond universities, this system can be 

implemented in primary and secondary schools, industrial and commercial companies for 

employee attendance tracking, hospitals, manufacturing firms, state institutions at local 

and central levels, and any other setting where participant registration and monitoring are 

needed, all while leveraging IoT technology. 

 

1. Introduction 
 

The Student Records Management System (SRMS) 

is designed to enable professors and assistants to 

generate and store attendance data for students 

during lectures and practical sessions. This digital 

system consists of three main components: 

hardware, software, and a web application, which 

utilizes IoT (Internet of Things) [1]. A digital RFID 

(Radio-Frequency Identification) device is installed 

at the entrance of each classroom within the 

university. When a student presents their personal 

RFID card near the reader, their attendance data is 

transmitted via Wi-Fi to the system’s database, 

recording the date and time of entry into the lecture 

or practical session [2]. If the same student scans 

their card again within the same date and classroom, 

the system, leveraging IoT, registers this as their exit 

time [3]. If the student scans their card for a third 

time, either at the same RFID device or another 

RFID device in a different classroom (within the 

same system), it is recorded as the start of another 

lecture or session. This process continues throughout 

the day from 7:00 AM to 8:00 PM.  

The RFID system ensures that the number of scans 

per student per day is always even, meaning the 

student has attended a specific number of lectures or 

sessions on that academic date [4]. If a student's card 

is scanned n times, the number of attended lectures 

or sessions for that day is jet 
𝑛

2
 , always resulting in a 

whole number. The web application, developed 

using PHP, HTML, CSS, and JavaScript, plays a 

critical role in the system’s functionality and is 

closely integrated with the digital hardware 

components. When a student’s RFID card is 

scanned, the application receives the data and 

archives it in a MySQL database. 

http://www.ijcesen.com/
http://dergipark.ulakbim.gov.tr/ijcesen
mailto:ragmi.mustafa@uni-gjilan.net
https://orcid.org/0000-0002-6995-5249
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The application, utilizing IoT, consists of two main 

modules: 

Administrator Module – Managed by administrator 

or authorized personnel, this module allows the 

configuration of digital devices within the system 

and the management of professor and student data 

[5]. 

Professor Module – Enables registered professors to 

log into the system using their personal accounts. 

Professors can manage student attendance records in 

real-time and at any point during the academic year. 

They can also generate student attendance reports 

based on parameters such as date, time of entry and 

exit, faculty, and classroom. 

 

A conceptual model of the SRMS system and its Wi-

Fi-based communication between digital devices, 

IoT components, and the web application is 

illustrated in Figure 1 [6]. 
 

 
Figure 1. Conceptual model of the SRMS system using IoT 

2. Material and Methods 

 
The digital devices are the core components of the 

Student Records Management System (SRMS). The 

device structure includes the following components: 

ESP8266 NodeMCU module, RFID reader, LCD 

(Liquid Crystal Display) screen, LED (Light-

Emitting Diode), buzzer, and connecting wires for 

electronic components.The NodeMCU board, in 

conjunction with the RFID reader, captures the chip 

ID from the student's card and transmits it via Wi-Fi 

router to the web application, where the ID is 

verified and recorded along with the student’s 

details. The hardware connection structure of the 

digital devices is illustrated in Figure 2 [7]. 

 

Figure 1. Physical connection diagram of digital devices 

 

The ESP8266 NodeMCU is an open-source 

microcontroller module, compatible with the 

Arduino UNO, and Wi-Fi-enabled, serving as a 

bridge between digital devices and the web 

application [8], [18-21]. The ESP8266 NodeMCU is 

powered by a 32-bit processor, making it an 

excellent choice for IoT and automation projects in 

various residential and workplace environments, 

specifically in university spaces for this use case. 

This microcontroller can function either as a 

standalone device or as a UART (Universal 

Asynchronous Receiver/Transmitter) to Wi-Fi 

adapter, allowing other microcontrollers, such as the 

Arduino UNO, to connect to a Wi-Fi network. 

The ESP8266 NodeMCU can operate in two modes: 

Access Point (AP Mode) – Generates its own Wi-Fi 

network. Station Mode (STA Mode) – Connects to 

existing Wi-Fi networks for internet access [9–11]. 

This capability enables the ESP8266 to access online 

services for HTTP (Hypertext Transfer Protocol) 

requests, store data in the cloud, and allow users to 

remotely monitor and control systems via IoT 

technology [12].  

RFID – (Radio-Frequency Identification) consists 

of two main components: RFID cards and an RFID 

reader. The RFID reader includes a radio frequency 

module and an antenna that generates a high-

frequency electromagnetic field. The RFID card is a 

passive device (it does not contain a battery or 

external power supply) and consists of a microchip 

that stores information and an antenna for receiving 

and transmitting signals. For the implementation of 

this system, the RC522 RFID module has been used. 

The table 1 presents the connection between the 

ESP8266 NodeMCU and the RC522 module [12]– 

[18], [23]. 

Table 1. Connection Between ESP8266 NodeMCU and 

RC522 RFID Module 

NodeMcu RFID-RC522 

D4 SDA/SS 

D5 SCK 

D7 MOSI 

D6 MISO 

GND GND 

D3 RST 

3V 3.3V 
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LCD Screen – I2C LCD 16x2 

The I2C LCD 16x2 display consists of 16 characters 

per row and 2 rows in total. Its purpose is to visually 

display data that is executed within the system. The 

LCD is connected to the ESP8266 NodeMCU, 

which sends the commands for displaying 

information. The table 2 shows the connection 

between the ESP8266 NodeMCU and the I2C LCD 

module [13–16]. 

 
Table 2. Connection between ESP8266 and RC522 

NodeMcu-ESP8266 Pin I2C LCD Pin 

GND GND 

VIN VCC 

D2 SDA 

D1 SCL 

 

LED and BUZZER– The LED (Light-Emitting 

Diode) is a semiconductor diode that emits light 

when a voltage is applied. In this case, a red LED is 

used. The Buzzer is a small speaker that produces 

sound when an allowable voltage is applied.  

The purpose of using these two components is to 

provide both a visual and an audible signal when an 

RFID card is scanned using the RC522 module. The 

LED and Buzzer are connected to the ESP8266 

NodeMCU via the D0 port.  

Current Limitation and Component Protection 

It is crucial to protect the ports of electronic devices, 

including the LED [25-27]. Excessive current can 

damage both the LED and the microcontroller pins. 

To limit the current, a resistor is placed in series with 

the LED. 

According to LED manufacturer specifications, the 

recommended voltage for a red LED is 2V DC, and 

the maximum continuous current should not exceed 

20mA [28-30]. 

To ensure the protection of ESP8266 pins, the 

required resistor value must be calculated and 

connected in series with the LED. 

The circuit diagram for the LED connection is 

illustrated in Figure 3, based on the schematic shown 

in Figure 2.  

 
Figure 3. Electrical Circuit for Connecting a Red LED 

to ESP8266 NodeMCU 

The allowed voltage for the red LED is 2 [VDC], and 

a sufficient current is 12 [mA], rather than the 

maximum 20 [mA], since the ESP8266 NodeMCU 

can supply this current from its pins. On the other 

hand, the minimum output voltage from the 

ESP8266 GPIO pin is 3.3 [VDC]. To ensure proper 

current limitation, we need to determine the resistor 

value 𝑅 that will protect both the LED and the 

ESP8266. By applying Kirchhoff’s Voltage Law 

(KVL) to the electronic circuit (as shown in Figure 

3), we can calculate the required resistor value in 

Ohms [𝛺]. 
3,3 [𝑉𝐷𝐶] − 𝑅 ∙ 𝐼 − 𝑅𝑑 ∙ 𝐼 − 𝑈𝑑 = 0  (1) 

𝑅𝑑 – The internal resistance of the diode is very 

small and is usually negligible in practical 

calculations (𝑅𝑑 ≪). Therefore, the following 

equation is obtained:  

3,3 [𝑉𝐷𝐶] − 𝑅 ∙ 𝐼 − 𝑈𝑑 = 0   (2)  

Therefore: 

𝑅 ∙ 𝐼 = 3,3 [𝑉𝐷𝐶] − 𝑈𝑑    (3) 

𝑅 ∙ 12 [𝑚𝐴] = 3,3 [𝑉𝐷𝐶] − 2[𝑉𝐷𝐶]  (4) 

𝑅 =
1,3 [𝑉𝐷𝐶]

12 [𝑚𝐴]
=

1,3 [𝑉𝐷𝐶]

12∙10−3[𝐴]
=

1,3∙103

12
[𝛺] =

1300

12
[𝛺] (5) 

𝑅 = 108,33 [𝛺] ≈ 100 [𝛺]   (6) 

Practically, a 100 [Ω] resistor is used because it is 

the closest standard value available in industrial 

resistor manufacturing. On the other hand, the 

buzzer used for sound production has technical 

characteristics very similar to the LED, both in terms 

of supply voltage and the permissible current 

intensity. Therefore, the LED and buzzer are 

connected in separate electrical circuits, with the 

buzzer also being protected by the same 100 [Ω] 

resistor. The calculation for the buzzer is entirely 

identical to that of the LED. 

If the 100 [Ω] resistor is not used in the electrical 

circuit, as shown in Figure 3, then Equation (1) 

would be defined as follows: 

3,3 [𝑉𝐷𝐶] − 𝑅𝑑 ∙ 𝐼 − 𝑈𝑑 = 0   (7) 

From this, it follows that the voltage across the LED, 

given that 𝑅𝑑 ≪ would be: 

𝑈𝑑 = 3,3 [𝑉𝐷𝐶]     (8) 

This voltage is 1.65 times higher than the allowed 

voltage for the red LED, where the maximum 

permissible voltage is 2 [VDC]. Therefore, such an 

excessive voltage would damage the LED.  

On the other hand, if we calculate the electric current 

intensity using Equation (7) for a supply voltage of 

3.3 [VDC] from the ESP8266 NodeMCU 

microcontroller and the allowed voltage 𝑈𝑑 of 2 

[VDC] for the LED, we obtain the following 

equation: 

𝐼 =
3,3 [𝑉𝐷𝐶]−2 [𝑉𝐷𝐶]

𝑅𝑑 [𝛺]
=

1,3 [𝑉𝐷𝐶]

𝑅𝑑 [𝛺]
   (9) 

The internal resistance of the diode is very low, 

especially when it is forward biased (𝑅𝑑 ≪).  As a 

result, the electric current intensity in the circuit 

where the LED is connected would be several times 
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higher than the allowed current for the LED. This 

excessive current would not only damage the LED 

but also burn out the output pins of the ESP8266 

NodeMCU microcontroller, or even the Arduino 

Uno if it were used in the system. The same issue 

would occur with the Buzzer, as it has similar 

electrical characteristics! 

 

2.1 Conceptual model of the Web Application 

 

In Figure 4 below, the conceptual model of the Web 

Application is presented. The model consists of two 

main modules: Administrator Module and Professor 

Module. 

Figure 4. Conceptual model of the Web Application 

2.2 Administrator module 

 

The Administrator Module includes the following 

menus: Home, Manage Students, Students, 

Professors, Faculties, Devices, Profile, and Log Out. 

With this module, all data related to students, 

professors, faculties, and devices can be modified, 

changed, or deleted. The module also allows the 

modification of administrator accounts, but the data 

cannot be changed without entering the correct 

password associated with the respective 

administrator's account. In Figure 5, the login form 

for the Student Records Management System 

(SMES) is shown.  

 

 
Figure 5. Login form for Administrator module 

Access is granted as an administrator only through 

email and password, ensuring that unauthorized 

logins are prevented from accessing the system [19-

22].  

The Students Menu contains a form that displays 

all the students registered in the SMES. Through this 

form, the administrator can search for student data 

based on the student's name, student ID, and faculty. 

The Manage Students Menu enables the 

management of registered student data and displays 

their information in a shared table. This page 

includes forms for adding new students, modifying 

the data of existing students, as well as deleting 

students from the system. 

The Professors Menu allows the management of 

registered professors' data and displays their 

information in a shared table. This page includes 

forms for adding new professors, modifying the data 

of existing professors, as well as deleting them from 

the system. 

The Faculties Menu enables the management of 

faculty data and displays it in a shared table. It also 

allows for the addition of new faculties within the 

university, modification of existing faculty data, and 

deletion of faculties. 

The Devices Menu allows for the management and 

configuration of devices. It also enables the addition 

of new devices, modification of the characteristics of 

existing devices, and deletion of devices.  

The Profile Menu allows for the modification or 

updating of the profile data of the administrator 

currently logged into their account. 

The Logout Menu allows the user to log out from 

the application and return to the login page. 

 

2.3 Professors module 
 

Professors module contains: Homepage, Profile and 

logout as shown in the Figure 6. 

Figure 6. Professors module menus 

The Home Menu contains a table displaying the 

attendance data of students present during lectures 

and exercises throughout the day at the faculty. 

Additionally, it includes a "Filter/Export to Excel" 

button, which allows the generation of student data 
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based on several parameters such as: date, entry and 

exit time, faculty, and room. 

The Profile Menu allows for the modification or 

updating of the logged-in professor's information 

within the application.  

The Logout Menu enables users to log out of the 

application and return to the login page. 

Initially, upon launching the SMES application, as 

shown in Figure 7, users are presented with the 

option to select their role before logging in, either as 

an administrator or as a professor. 

 
Figure 7. Homepage of SRMS system 

Configurations:  

To fully operationalize the SRMS system several 

configurations must be made in Arduino IDE [20]: 

1. Open IDE 

2. Go to File > Preferences (or press CTRL Key + 

comma) 

3. Copy: 

http://arduino.esp8266.com/satble/package_esp8

266com_index.json in Additional Boards 

Manager URLs. 

4. Go to Tools > Boards Manager and install 

esp8266. 

5. Go to Tools > Port and select the port on which 

is connected esp8622. 

In the following section of the program code, the 

SendCardID method is created initially with the 

RFID card ID as a parameter [18-19]. Then, we 

declare an object of the HTTPClient class to send 

requests and receive responses. We also declare the 

getData variable, which is used to obtain the ID 

value. Once the request is initialized, it sends the 

ID and receives a response, which is displayed on 

the LCD screen. 

void SendCardID(String Card_uid){ 

If(WiFi.isConnected( ){ 

HTTPClient http; 

getData = ”?card_uid=” + String(Card_uid) + 

“&device_token=” + String(device_token); 

http.begin(Link); // start HTTP request 

int httpCode = http.GET( ); // send request 

String payload =- http.getString(); // get response 

Serial.println(httpCode); // print HTTP returned 

code 

Seria.println(Card_uid); // print ID card 

Serial.println(payload); // print request – response 

payload. Printing request in LCD screen 

lcd.clear( ); // clear screen 

lcd.setCursor(0, 0); // put cursor in the screen with 

coordinates  (0, 0) 

lcd.print(payload) // print payload value 

delay(2000); // wait 2 seconds repeating the infinite 

cycle of the program code 

lcd.clear( ); // clear the screen 

 

3. Results and Discussions 
 

The Student Records Management System (SRMS) 

using IoT provides an excellent solution for 

digitalization, transparency, and accuracy in 

generating student attendance lists for lectures and 

exercises. Initially implemented at the Faculty of 

Computer Sciences, it has since been extended to 

other faculties at the "Kadri Zeka" Public University 

in Gjilan, in the world's newest state, the Republic of 

Kosovo. Naturally, this same digital system, which 

utilizes IoT, can be applied to universities and 

colleges across the entire territory of the Republic of 

Kosovo and potentially beyond. Until now, 

professors and assistants have manually recorded 

student attendance with printed lists, where students 

wrote down their data at the beginning of the class. 

This method of keeping records consumed valuable 

teaching time for professors and especially the 

students' learning time, particularly when the 

number of students present was in the tens, and 

sometimes even hundreds or more.  

To make optimal use of lecture and exercise time, it 

was a request from students, professors, assistants, 

and university management to find an innovative 

way to record student attendance during classes. 

Therefore, by leveraging information technology, 

smart devices like microcontrollers, IoT, and 

programming languages, this classic problem has 

been transformed into an excellent digital innovative 

solution that resulted in an artificial intelligence-

powered system. All of this meets a condition of the 

Bologna system, which has been in place in the 

Republic of Kosovo for around twenty years. 

According to the Bologna system, the student's 

attendance in lectures and exercises is considered 

when evaluating the final grade at the end of the 

semester. The method of determining the professor’s 

decision regarding the final grade for a passed exam, 

expressed as a percentage based on the student's 

academic activity, is shown in Table 3. In cases 

where a student has not been regular in attending 

lectures and exercises, they automatically lose 10% 

of their grade, which corresponds to 10 points out of 

the total 100 points available. 

http://arduino.esp8266.com/satble/package_esp8266com_index.json
http://arduino.esp8266.com/satble/package_esp8266com_index.json
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Table 3. The grading criteria for students according to 

the Bologna university system 

Academic activity Percentage % Points 

Colloquium-First test 10% 10 

Colloquium-Second test 10% 10 

Homework 10% 10 

Regular attendance, 

lectures and exercises 

10% 10 

Seminar paper 10% 10 

Final exam 50% 50 

Total: 100% 100 

 
Table 4. Grades of students based on the points 

accumulated during the course activities 

Points Grade 

(number) 

Grade (Letter) 

91 – 100 10 A 

81 – 90 9 B 

71 – 80 8 C 

61 – 70 7 D 

51 – 60 6 E 

1 – 50 5 FX 

 

Therefore, the maximum grade they can achieve is 

no higher than nine, since passing grades according 

to the Bologna system range from six to ten, as 

shown in Table 4. 

The manual system of record-keeping was not only 

a laborious task but also frustrating for professors 

and assistants to compile attendance records for each 

student, especially when the number of students per 

professor or assistant exceeded hundreds. 

Determining the percentage of students present in 

lectures and exercises was particularly difficult. 

With the introduction of SMES, this problem has 

been completely eliminated. The digital platform 

allows generating student lists in Excel spreadsheet 

format for each class session throughout the 

semester. Additionally, with minimal effort, data in 

Excel tables can be filtered, sorted, or separated 

based on dates, days, months, or six-month periods, 

providing the necessary information for professors. 

Another positive effect of this digital system is the 

increased attendance rate of students in lectures and 

exercises. By using IoT, specifically Wi-Fi in this 

digital system, multiple connections and distances, 

which may reach tens of meters for the hardware 

components, especially the RFID components, are 

avoided. These components are placed at the 

entrances of each lecture hall distributed across the 

university's facilities [24]. In fact, SMES can be 

expanded, enhanced, or edited to achieve better 

performance and effects that have not been utilized 

until now. Therefore, a scientific paper like this will 

help future researchers develop even more advanced 

intelligent systems. 

  

4. Conclusions 
This innovative and scientific work, based on 

hardware and software utilizing IoT, in fact 

represents an Artificial Intelligence system for 

managing student attendance in the educational 

process at "Kadri Zeka" University in Gjilan, 

Republic of Kosovo. SMES enables the following: 

1. Reducing the time spent recording student 

attendance in lectures or exercises according to 

the courses in the university's faculties. 

2. Increasing the valuable time of lecturers during 

teaching hours in university courses. 

3. Simplifying attendance tracking by excluding the 

traditional method of handwritten notes on paper. 

4. Generating reports for professors and assistants 

regarding the teaching hours and student 

attendance. 

5. For each lecture during the respective semester, 

generating student attendance in the form of 

electronic sheets in Microsoft Excel and creating 

easy options for printing and further processing. 

6. Adding RFID devices to the system for new 

classrooms and simultaneously adding students, 

professors, and assistants whenever the need 

arises. 

7. Modifying or even removing students, 

professors, and assistants whenever necessary. 

8. Ultimately, digitizing the tracking of student 

attendance in lectures and exercises. 

9. Electronic confirmation of the lecturers' and 

assistants' teaching hours for the needs of 

university management, especially for the 

finance department. 

10. Creating an intelligent system that embodies 

Artificial Intelligence. 
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